Quick Start Guide for *CBECC-COM 2019.1.0*

Version CBECC-Com 2019.1.0  
May 2019

**NOTE:** Please check [http://bees.archenergy.com/](http://bees.archenergy.com/) for any updates to this guide.

**Overview**

*CBECC-COM* is an open-source software program developed by the California Energy Commission for use in showing compliance with the *Non-Residential Building Energy Efficiency Standards*. This Quick Start Guide is for *CBECC-COM 2019* released in May 2019. This version has been approved by the California Energy Commission and can be used to show compliance with the 2019 Title-24 Standards.

This Quick Start Guide provides brief descriptions of the software program's major features. It is a good idea to review the Quick Start Guide before using the program for the first time or if you have questions while using the program. Additional Help features will be added to future versions of the program.

**Notice to Users:**

CBECC-Com has been previously compiled and available for 32-bit Microsoft Windows operating systems. To be compatible with the Department of Energy's new 64-bit versions of OpenStudio v2.x and EnergyPlus v9.x, the upcoming certified release of CBECC-Com 2019 will only support 64-bit Windows operating systems and will end support for 32-bit Windows operating systems. Upgrading to these new versions brings various improvements and bug fixes that will allow CBECC-Com to take advantage of new features and enhancements that are necessary so CBECC-Com's capabilities can keep moving forward. The 2019 Building Energy Efficiency Standards go into effect January 1, 2020 so we encourage users to verify their operating systems are 64-bit well in advance of the effective date.

**Capabilities:**

Calculate the annual energy use for both the Proposed Design and the 2019 Standard Design of non-residential buildings.

**Included in Version 2019.1.0 (Based on proposed 2019 Title 24 Part 6 Measures)**

**Simulation Engine Update**

- The simulation engine has been updated from EnergyPlus 8.5 to EnergyPlus 9.0.1.

**New HVAC Systems**

- Multi-zone variable refrigerant flow (VRF) cooling and heat pump systems can now be modeled.
- A new ZoneSystem type, ‘VentilationOnly’, has been added to support a simpler way of describing small, single-zone, primarily residential ventilation systems. The available options for this new system include ‘ExhaustOnly’, ‘SupplyOnly’, ‘Balanced’, and ‘HeatRecovery’.
- Water-cooled cooling and heat pump coils are now allowed to be used in AirSystems.
- Two-speed fans are now supported for fan-powered ZoneSystems SZAC, SZHP, PTAC, PTHP, and WSHP.
• DOAS systems can now be connected to supply air to the inlet side of fan-powered ZoneSystems.
• ActiveBeam terminals can now be modeled with both cooling and heating coils.

Revised Standard Design HVAC System Map
• For residential zones (high-rise residential and hotel/motel guestrooms), the standard design system is SZAC if the building is <8 stories above-grade, otherwise FPFC.
• For Retail zones in buildings 2 floors or fewer, the standard design system is SZAC if net cooling capacity is <65 kBtu/hr, or otherwise SZVAVAC.
• The nonresidential standard design system map, not including covered processes, has been revised, and is now more consistent with the ASHRAE 90.1 Appendix G baseline system map. If the standard design system is SZVAVAC, but the net cooling capacity is <65 kBtu/hr, it is modeled as SZAC.
• Systems that serve ‘Healthcare’ zones are passed through to the standard design unchanged. With the exception of minimum efficiency requirements, healthcare HVAC systems are exempt from compliance.
• Baseline system for process Laboratory and Commercial Kitchen zones adjusted, and inputs/rules for Laboratory systems revised for consistency with CASE team recommendations.
• DOAS systems can now be specified as exhaust systems for zones that require exhaust.
• Unmet load hour (UMLH) thresholds are now enforced for zones with new HVAC systems, excluding zones that qualify as ‘Healthcare’, zones where HVAC will be permitted in the future, and in zones without a cooling system where a cooling system is added to the model for compliance (heating UMLH criteria still applies).

Nonresidential Indoor Air Quality
• An input has been added to the Space data screen for selecting the appropriate ventilation space function, as defined in Tables 120.1-A (outdoor air) and 120.1-B (exhaust). Proposed models must now include exhaust systems when exhaust is required by Table 120.1-B.
• The number of occupants in a nonresidential Space, if known to be different than the NACM defaults, can now be increased above the default. The user input will be used in simulating occupancy loads and calculating ventilation rates.
• Calculation of residential ventilation rates has been updated to follow Section 120.1(b)2. Continuous operation of residential heating/cooling systems to also provide ventilation air is no longer allowed.
• The ventilation and exhaust airflow reflected in the standard design model equals the proposed as long as it is with -5%/+10% of the calculated minimum required for nonresidential spaces, and -5%/+20% for residential spaces. Ventilation air among non-process, nonresidential spaces on a BuildingStory is assumed to be transferrable.
• The exception for DCV in classrooms has been removed.

Current limitations:
- The modeled space occupancy is based on the maximum of the NACM default or user input occupancy, not the assumed occupancy of the ventilation function defined in Tables 120.1-A. For demand controlled ventilation (DCV), the cfm/person is calculated based the ratio of the modeled space occupancy and the occupancy assumed for calculating the ventilation cfm/ft2 in Table 120.1-A.
Fan System Power
- The standard design fan power allowance has been updated to reflect Section 140.4(c) Option 2. Fan power pressure adjustments applicable to the performance method can now be selected for AirSystem/ZoneSystems, and the adjustments will be applied to the corresponding standard design HVAC systems. Special allowances for systems covered under Section 140.9 have also been implemented.
- Laboratory fume hoods, including the fraction with automatic sash controls, as well as minimum (unoccupied) exhaust and ventilation air flow rates for laboratory zones, can now be specified. Rules have been revised to apply the updated Section 140.9(c) requirements to the Standard Design.
- For laboratory exhaust systems, there are options to indicate anemometer or contaminant-based controls is provided. This results in a fan power adjustment applied to the user-input laboratory exhaust power in the simulation.
- Relief fans are no longer included in the standard design, and simulated with zero fan power if included in the proposed model.

Current limitations:
- Fan power adjustments are not supported for a second, independent primary air conditioning system.

Equipment Efficiency Changes
- Updated minimum efficiency requirements for SPVAC and SPVHP systems to match new values in Table 110.2-E.
- Modified the efficiency of cooling towers in standard design models. In climate zones 1 and 16, it is always 42.1 gpm/hp. In other climate zones, it is 60 gpm/hp when the chilled water plant design flow rate is 900 gpm or more, and 42.1 gpm/hp when the chilled water flowrate is less than 900 gpm. Checks were also added that will trigger errors if the cooling tower efficiency does not meet the mandatory requirements from Table 110.2-G.

Nonresidential Indoor Light Sources
- Revised standard design general lighting power allowances (Area Category and Tailored) for 2019 as per Table 140.6-C.
- Revised additional allowances (Area Category and Tailored) for 2019 as per Table 140.6-C.
- Revised space function list for 2019 based on Table 140.6-C.
- Provide backward compatibility for models with 2016 and earlier space functions.

Nonresidential Indoor Lighting Controls
- Revised lighting control credits for 2019 (implemented as Power Adjustment Factors, or PAFs).
- Updated rules and screens to allow multiple PAFs for a single luminaire, where allowed by Table 140.6-A.
- Updated rules to allow users to specify windows as clerestories, which disables daylighting impact from these windows and may allow selection of PAF for clerestories. Exceptional condition flag added to notify plan reviewers that project includes clerestories.
Service Water Heating

- Each space function is now defined as having service hot water loads served by a gas or electric water heater in the baseline. Accordingly, the baseline model may now include a hot water system with a gas water heater, one with an electric water heater, or two hot water systems, one gas and the other electric.
- Sizing of the baseline water heating system (or systems) is now based on the total hot water consumption rate of the spaces connected to the system. This sizing however is limited such that it will not exceed the total capacity (heat input plus storage) of the service hot water systems in the proposed, and it will not be less than a capacity that corresponds to a storage water heater with a 30 gallon tank. If there are two baseline systems, the combined capacity of the two systems is subject to the same 30 gallon nominal capacity, prorated between the two systems based on the total hot water consumption of each.
- Updated rules for highrise residential domestic hot water systems to follow the Title-24 2019 Residential modeling guidelines.
- Water heaters being defined in the model for New Construction projects will now use the new federal categories and efficiency guidelines (UEF, First Hour Rating etc.). The new water heater categories include Consumer, Commercial and Residential-Duty Commercial. Water heater categories such as Small/Large will no longer be available unless the project is being modeled as an Existing Addition/Alteration in which case the existing water heater can still be defined using those properties.

Residential Service Water Heating

- Updated Standard design to include electric water heating. When there is an electric or heat pump water heater in the proposed building, the Standard Design is now a generic heat pump water heater with a 2.0 UEF, basic compact distribution, and shower drain heat recovery dependent on the climate zone. When a building is all electric, the Standard Design is now all electric. This is available at this time for systems serving individual dwelling units or multiple units if there is no recirculation system.
- Added modeling support for Compact Distribution System. Compact Distribution System modeling includes options including Not Compact, Basic Credit and Expanded Credit for which HERS verification is required. For CBECC-Com the Compact Distribution System is defined at the Space level in the 'Dwelling Unit Data' tab.
- Added modeling support for Drain Water Heat Recovery. For CBECC-Com the Drain Water Heat Recovery is defined at the Space level in the 'Dwelling Unit Data' tab. Multiple Drain Water Heat Recovery devices can be used for a water heater system. HERS verification is required to meet the criteria as listed in the Residential Appendix RA3.6.9.
- Water heaters being defined in the model for New Construction projects will now use the new federal categories and efficiency guidelines (UEF, First Hour Rating etc.). The new water heater categories include Consumer, Commercial and Residential-Duty Commercial. Water heater categories such as Small/Large will no longer be available unless the project is being modeled as an Existing Addition/Alteration in which case the existing water heater can still be defined using those properties.
Pump Configuration
- Added checks to ensure that all the pumps on a primary fluid system loop have the same speed control type (variable or constant). Removed overly restrictive checks on pumps serving thermal energy storage systems.

CALGreen and HERS Reporting
- Added a new project level tab for reporting CALGreen Tier 1/Tier 2 requirements.
- Added a new project level tab for measure where HERS verification is required.
- Added reporting of CALGreen Tier 1/Tier 2 compliance on the analysis results screen.

Photovoltaic Arrays
- PV arrays can be created & edited from the Mechanical tab of the main view either via menu option Edit > Create Component or right mouse click on the Project object (in Mechanical tab) > Create > PhotovoltaicArray.
- Inputs here modeled after those present in CBECC-Res, including DC system size, module type, inverter efficiency and either CFI (California Flexible Installation) or azimuth and tilt specification.
- Simulation of PV arrays done using CSE (based on PVWatts® calculator).
- More detailed geometry inputs and gbXML import (from Euclid SketchUp plug-in) coming in future release.

Battery
- A battery storage system can be coupled with one or more PV arrays, also created & edited from the Mechanical tab of the main view either via menu option Edit > Create Component or right mouse click on the Project object (in Mechanical tab) > Create > Battery (limit of one battery per model).
- Primary battery inputs include capacity (minimum 5 kWh), control scheme and charging & discharging efficiency.
- Control schemes include:
  - Basic - charges whenever there is excess PV and discharges to meet building load when PV does not cover it.
  - TOU - charges whenever there is excess PV and discharges at maximum rate only during peak period (that varies by climate zone)
  - Advanced DR - uses all PV to charge the battery until it is full and discharges at maximum rate during highest TDV hours for peak days, otherwise runs with basic control.

Note: Simulating Photovoltaic and Battery Storage will result in a watermarked report.

New Envelope Components
- Windows can now be modeled on interior walls. In the Standard Design model, windows on demising walls are subject to minimum U-Factor requirements. Daylighting through windows on interior walls is not supported.
- Implemented updates to the thermal performance of spandrel panels and curtain walls from the 2019 Standards.
Software & User Interface

- Added new grid-based view/edit of building model data, available via menu option Tools > Show Model Grid. Displays in resizable window with object/topic/property organization based on tabbed dialog interface. Multi-object/cell clipboard copy/paste to/from spreadsheet applications with data type and numeric range verification. Grid object sorting via column header selection and additional object sorting & filtering options to come in future releases.

Bugs Fixed/Enhancements in Version 2019.1.0 / 2019.1.0 RC:

- Remove requirement that DOAS AirSystems be night cycled if there is zone heating/cooling equipment.
- Night cycling for ZoneSystems is now supported. However, if these systems are the ventilation source for a zone, outside will be provided when night cycling occurs.
- Night cycling for AirSystems updated to use the E+ AVM:NightCycle cycling control option ‘ThermostatWithMinimumRunTime’.
- ZoneSystems with heat pump heating coils were previously modeled with a supplemental electric heating coil, even if one was not specified in the model; this has been fixed.
- For residential spaces, a balanced ventilation system is required unless a HERS exception for air leakage is used. An exceptional conditional is now triggered if an un-balanced ventilation system (supply or exhaust) is specified. A project cannot combine balanced, supply, and exhaust systems for residential spaces in the same model; they all must be of the same type.
- Plant scaling rules for plants serving system in additions/alterations, healthcare facilities, and core and shell have been implemented for the scenario that there is one plant (i.e. one hot water, chilled water, and/or condenser water FluidSystems) in the model. That is scaling for models that have more than one chilled water system are not expected to scale properly.
- Bugs in exhaust fan rules fixed, including an error related to motor HP inputs, and modeling infiltration in unconditioned zones that have exhaust systems, such as parking garages.
- Fixed an issue for residential units served by combination DHW/heating systems where service hot water systems were not simulated or the baseline did not have SHW systems for these spaces. The rules were modified to correctly generate the baseline SHW system and simulate SHW in the proposed and baseline models.
- Changed the EnergyPlus translation for cooling towers to avoid errors in calculating required UA properties.
- Changed the EnergyPlus translation to apply a SetpointManager:DualSetpoint on the fluid systems when dual fixed setpoint control is specified in CBECC-Com. This fixes issue with condenser water temperature control, typically used with WSHP systems.
- Fix bug that caused user specification of AirSystem optimum start control to not be modeled.
- Fix bug in AutoEfficiency defaulting rules that caused user specification of fan power in some cases to be ignored.

Bugs Fixed/Enhancements in previous 2019 Research versions:

- For proposed AirSystems with relief fans, these fans would run at the minimum OA rate whenever the system is enabled. This is not consistent with typical operation and the Standard Design does not include relief fans, so proposed relief fans are now modeled with 0 power so they do not impact compliance.
• Updates to rules to allow nameplate <1/16 HP motors to be specified.
• Fix input screen for coils that use ‘WaterSource’ condenser.
• Update minimum prescriptive VT rules to avoid ‘divide by zero’ error for projects with WWR = 0.
• Fixed calculations for closed and evaporative closed cooling towers and added multiple checks for potentially problematic input values. Most of these new checks provide warnings to help the user identify problems without stopping the analysis. Added a Project Remarks section to the ‘Narrative’ tab at the project level for users to put in notes related the model which will not be printed on the PRF-01 report.
• Updated the project level ‘Form’ tabs to reflect changes for the Title-24 2019 Standards.
• Removed support for modeling solar hot water heating (Annual Solar Fraction) for service hot water heating serving non-residential spaces.
• Added two new toolbar items. They are next to the perform analysis button. One is “analysis results” (which is equivalent to tools/review analysis results) and the other is “compliance results” which will either open an existing PRF-01 or generate a draft PRF-01 report.
• Added a new feature that allows batch processing, which means running multiple files. It will be useful if you’re coming up with options for achieving compliance, or running comparisons. It is accessible from the start-up menu (or from tools/batch processing). When complete, you will have a single log file, a results file, and multiple XML files and PRF-01s.
• Update rules to allow WaterSource condenser to be used for DX coils in AirSystems.
• Updates to rules addressing issue where polyLoop errors occur in simplified geometry model due to extremely shallow window fins & overhangs. Minimum fin/overhang depth increased from 0.001 to 0.05
• Updates to CBECC-Com 2016/19 executables to fix CSE simulation failure when the CSE object name was more than the CSE character limit.
• Updates to CBECC-Com 2016/19 executables to fix a problem related to unreferenced objects not being entirely purged prior to simulation. Updated code to ensure that groups of unreferenced objects (such as SchDay/SchWeek/Sch) that can include references within each other all get cleaned up prior to each simulation.
• Revise baseline DX cooling coil sizing to ensure cfm/ton is between 280 and 450 cfm/ton, including for 100% OA systems.
• Revise rules to ensure fan power is correctly displayed when changing between modeling methods.
• Updates to rules to report Domestic Hot Water (DHW) budget when DHW is excluded in a highrise residential model and no residential DHW system is modeled.
• Updates to rules to add a warning to the user interface and log file when a user has modeled a glazing with VT < prescriptive minimum. This condition triggers a lighting penalty which is implemented by reducing the baseline LPD by a factor of 0.833.
• Updates to various material properties and addition/removal of materials.
• Heat rejection systems now allow use of closed cooling towers and evaporative closed cooling towers. Inputs are similar to those for open cooling towers, with the addition of a water spray flow rate for evaporative closed cooling towers.
• Updates to rules and user interface to remove “Zone Designed Without Cooling” option. If the proposed has no cooling, a minimum efficiency air-source DX system is now always added to the zone for compliance analysis.
• Updates to allow ‘FPFC’ ZoneSystems to be modeled without a chilled water coil (two-pipe heating only system). Currently, only constant volume fan control is allowed for this system configuration. Update includes revise fan sizing ratio to 1.0 for these systems.
Updates to rules for detailed geometry models to modify the space area calculation to be based on the sum of the floor objects in the space, rather than using the space polyloop. A warning will be added to the log file where the area of the space polygon is not equal to the sum of the floor objects defined in the space.

Updates to the space function table to add an “All Other” category.

Updates to rules for high-rise residential domestic hot water heating to include option for credit/penalty for solar thermal when water heating is excluded and is submitted prescriptively for compliance.

Update ventilation rules to allow residential and nonresidential ventilation rates to be between 95% and 110% of code w/o any adjustments. If the proposed design is greater than 110%, the standard design will be reduced down to 110%.

Fixed issue where systems supplying ventilation air via DOAS and/or the Primary Air Conditioning System to residential spaces would result in extra infiltration, as if the ventilation was by exhaust fan.

Fix code minimum efficiency rules for Minisplit AC/HP systems, and revise default ZoneSystem:SubType to be Split1Phase.

Update calculation of prescriptive minimum VT to include minimum from Table or Equation 140.3-B. If applicable, equation 140.3-B is used only to determine whether a lighting penalty is applied in simplified geometry models. The standard design VT is always determined from Table 140.3-B.

Feature added to speed user input of large, complex models by postponing input defaulting based on actions taken by the user. Options for new properties Proj:DefaultOptionInp, DefaultOptionObj & DefaultOptionDone (editable on Project / Analysis Options) include 'Nothing', 'Modified Object' and 'Entire Model' (all defaulting to 'Entire Model', equivalent to defaulting in past releases). Iconic 'D' buttons added to tabbed dialogs and toolbar to manually force defaulting of active object or entire model.

When wet-bulb reset is selected as the control method for a fluid system (normally used for condenser water systems), the field for minimum reset supply temperature is now available for user input. Previously, this value was prescribed at 65°F, which may not be low enough for some applications, particularly when a water-side economizer is used.

The ability to include two metal framed composite layers in an Exterior Wall construction has been added. The two layers are defined as normal with the Code Category of “Composite”, and they are then added to the construction assembly as normal. The layers may be the same layer used twice. The only restriction is that some other layer must be placed between the two composite layers. Also, only one composite layer is allowed in construction assemblies intended for other surface types, and the two layers in an exterior wall construction must be metal framed.

Update prescriptive daylighting exceptional condition rules to trigger the exceptional condition only in cases where total project new window area > 0. Added flag to allow users to invoke exceptions 1 and/or 2 to 130.1(d)2 for an entire project, exempting them from prescriptive daylighting requirements.

Fix to executables that prevented calculation of TDV results for enduse(s) where initial hours/days of simulated energy use were negative values.

Updates to high-rise residential water heating rules to be consistent with the residential water heating rules.

Various updates to rules for reporting and updates to reporting template.
Known Issues:

- General Issues
  - No resizing of baseline systems if unmet load hour (UMLH) requirement is not met.
  - Additions/Alterations analysis and inputs are supported, but analysis has not been fully tested and may not work properly.

- Spaces
  - Increasing the number of occupants in the space only currently impacts the ventilation calculation when using DCV.

- HVAC Secondary Systems
  - Simulation of supply air temperature and flow controls may not match ACM requirements.
  - Specifying DCV for all zones of a multi-zone system results in unexpectedly high energy use.
  - The simulated supply air temperature for FPFC systems may be less than expected; which can result in more hours of fan operation and therefore high fan energy use.

- HVAC Primary Systems
  - Some models with constant speed pumps on hot water loops may see errors where the water temperature exceeds upper limits due to an EnergyPlus issue where pumps run and add heat to the loop during periods when there is no heating demand.
  - All pumps on primary loop of primary/secondary pumping systems will run if there is any demand on the secondary loop.
  - Evaporative-only cooling systems that cycle to meet cooling loads are not simulated correctly.

- Residential Service Hot Water Heating
  - Residential Service Hot Water systems modeled in earlier version of the software (2019.0.3 and earlier) and having Dwelling Unit Distribution set to compact distribution will be mapped to the ‘Standard’ option on opening in the 2019.0.4 Alpha release. Users will need to manually select the new Compact Distribution Options located at the Space level in the ‘Dwelling Unit Data’ tab.

- Material Data
  - The values in Table 4.3.8 of JA4 are being reviewed for potential revision. Spandrel panel and curtain wall material data are based on the current values in the table.
Example Input Files: A series of example models are installed along with CBECC-Com in the Projects directory. These models are of various building types and HVAC systems.

CEC Standard Tests
1. 010012-SchSml-CECStd
2. 020012-OffSml-CECStd
3. 020012S-OffSml-CECStd
4. 030012-OffMed-CECStd
5. 030012S-OffMed-CECStd
6. 040012-OffLrg-CECStd
7. 050012-RetlMed-CECStd
8. 060012-RstntSml-CECStd
9. 070012-HotSml-CECStd
10. 080012-Whse-CECStd
11. 090012-RetlLrg-CECStd

VRF Tests
1. 021013-OffSml-VRFSys
2. 021015-OffSml-VRFSys
3. 021016-OffSml-VRFSys
4. 021113-OffSml-VRFSysHR
5. 021115-OffSml-VRFSysHR
6. 021116-OffSml-VRFSysHR

Other Tests
1. 010112-SchSml-PSZ19
2. 010212-SchSml-PVAVAirZnSys19
3. 010312-SchSml-VAVFluidZnSys19
4. 040112-OffLrg-AbsorptionChiller19
5. 040112-OffLrg-VAVPriSec19
6. 040112-OffLrg-Waterside Economizer19
7. 050112-RetlMed-SZAV19
8. 050312-RetlMed-Alterations19
9. OffLrg-PlenumsFPBsData19
10. OffLrg-PrkgExhaust19
11. OffLrg-PrkgLab19
12. OffLrg-PrkgLabKitchen19
13. OffLrg-RetailLhthcare19
14. OffLrg-RetailLhthcarewithPlant19
16. OffLrg-ThermalEnergyStorage_StoragePriority19
17. OffMed-CoreAndShell19
18. OffMed-CoreAndShellwithPlant19
20. OffSml-ActiveBeams19
21. OffSml-CombDHWSpCht19
22. OffSml-CommKit_SZAV19
23. OffSml-Data_SZAV19
24. OffSml-HtRcvry19
25. OffSml-Lab_SZAV19
26. OffSml-MiniSplit19
27. OffSml-Office_SZAV19
28. OffSml-PassiveBeams-DOASCV+HtRcvry19
29. OffSml-PassiveBeams-DOASVAV19
30. OffSml-PassiveBeams19
31. OffSml-PSZ-Evap19
32. OffSml-WSHP19
33. RetlMed-PVAV-IndirDirEvap19
34. RetlSml-DOAS+FPFC19
35. RetlSml-DOAS+GravityFurnace19
Quick Start Guide Topics

Menu of Topics in this Quick Start Guide
Updates
Starting a New Project
Analysis Types
Compliance Types
Menu Bar
Tool Bar
Main Screen
Right Mouse Button Menu Options
Building Tree Controls (Parent/Child Relationships)
Input Dialog Windows
Status Bar
Defining New Components
Deleting Project Files
How to Report a Problem
License Agreement

Updates and New Project Website
We plan to issue updates to CBECC-Com often. You can check the new project website (http://bees.archenergy.com/) where a link to the latest version will always be posted.

Starting a New Project
When CBECC-Com is first started, a dialog box will appear with the options (No. 2 option may not be available on new CBECC-Com installations):

1. Open Recent Project
2. Select an Existing Project to Open
3. Create a New Simplified Geometry Project

Option 1 and Option 2 are essentially the same, except that the “Open Recent Project” option automatically selects the project that was being worked on the last time CBECC-Com was open. The “Select an Existing Project to Open” option simply requires browsing to the desired project.

If “Select an Existing Project to Open” is selected, the default file type in the browse window is a .cibd16 file. However, this can be changed to .cibd16x or .xml, allowing you to open a SDD XML file. This option should be used when working on a Detailed Geometry project.

Users can take either approach (Detailed or Simplified – see User’s Manual for more information) to modeling their project; however, the preferred workflow is to use the Detailed Geometry approach using OpenStudio to create building model geometry using SketchUp with the OpenStudio plug-in. OpenStudio includes an option for exporting an SDD file, which CBECC-Com can then open. The Simplified Geometry approach is recommended for simpler buildings since this approach comes with
certain limitations that could prevent the project from getting credit for certain efficiency measures included in the design.

For more information on the recommended workflow, please view the tutorials at http://bees.archenergy.com/faq.html.

Analysis Types

**Title24ProposedOnly:** This will simulate the building input by the user with the 2019 compliance rules.

**Title24Compliance:** In addition to simulating the Proposed Design, this will simulate the Standard Design building which complies with the 2019 Prescriptive Standards and establishes the energy budget for compliance.

Analysis Scope Options

The scope of analysis is specified through use of a series of checkboxes. Use of these checkboxes results in specification of Compliance Type, which was input directly in CBECC-Com 2016.2.1 and earlier versions.

**New and Existing.** One (and only one) of these two boxes must always be selected. In the CBECC-Com UI, checking or unchecking either of these options results in the other option automatically being set the opposite way.

*New* should be selected when the project involves construction on a site where there is not an existing building or where the subscope (described below) has not been previously constructed. For example, if a new building has been built with tenant spaces that did not have lighting or mechanical systems, a subsequent analysis addressing the lighting or mechanical systems for those tenant spaces is still New, even though the building shell is existing. On the other hand, if that same tenant space is remodeled later, analysis of that project would use *Existing*.

*Existing* should be selected when the project is an addition to an existing building or when an existing building is being altered, or both.

**Addition and Alteration.** When *Existing* has been selected, the *Addition* and *Alteration* checkboxes must be used. At least one of these must be selected, and both may be selected. An *Addition* means that new conditioned floor area is being added to the building, and the construction related to that new floor area is treated in the same way as new construction. *Alteration* means that portions of the existing building are being changed in ways that affect the energy performance, but without adding new conditioned floor area. When alterations are analyzed, determining the characteristics of the baseline follows different rules than new construction.

When an *Existing* building is described in CBECC-Com, careful attention must be paid to properly specifying the *Status* of all components to be *New, Existing, Altered, or Future*, in order to achieve a valid analysis.
**Envelope, Lighting, Mechanical, DHW.** These checkboxes allow analysis of partial compliance options. These options are used when only the specified aspects of the building are included in the building permit and energy performance analysis.

**Partial Lighting, Partial Mechanical.** These checkboxes allow analysis of core and shell projects, where a portion of the lighting or mechanical systems in the building are included in the building permit and energy performance analysis, but other portions have either already been built or will be built in the future.

Note that if some combinations of *Existing, Addition and Alteration* are selected, then *Envelope, Lighting, Mechanical, Partial Lighting, and Partial Mechanical* may be automatically checked or unchecked and the user may not be able to change those selections. In this case, the *Status* of individual components in the model will determine how the analysis will proceed.

**Envelope.** For all models, the building envelope, including opaque surfaces and fenestration must be described in the user’s input model, which will provide the basis of the proposed model. When Envelope is not checked, it is assumed that the envelope is existing and the envelope in the baseline model will match the proposed model. If the project includes any new or altered envelope components, then *Envelope* must be checked and the status of envelope components will determine how the baseline model is specified.

**Lighting and Partial Lighting.** If the project includes any new or altered lighting systems, then *Lighting* or *Partial Lighting* must checked. The status of the lighting in each space will be used to determine the characteristics of the lighting in the baseline.

For a *New* project, if lighting will be designed and permitted are some point in the future, *Lighting* must be left unchecked. The *Status* of lighting in all spaces will default to *Future*. In both the proposed and baseline models, lighting will be specified by the rules and will normally be identical. If the lighting in all spaces has been designed and is being permitted, then *Lighting* should be checked. If the lighting for some spaces is designed and included in the permit, but the lighting for other portions of the building will be designed and permitted in the future, such as for a core and shell project, then *Partial Lighting* should be checked.

For an *Existing* project, if *Lighting* is unchecked, then the *Status* of the lighting in each space may be set to either *Existing* or *Future*. If the *Status* of the lighting in a space is set to *Existing*, that same lighting will be used in the baseline. If the Status is set to *Future*, then the rules will determine the lighting for both the proposed and baseline (same as for *New* without lighting).

If the *Status* of the lighting in any space will *New* or *Altered*, then either *Lighting* or *Partial Lighting* (but not both) must be checked. In this case, the baseline lighting will be different from the lighting in the proposed model. If a project is *New* or an *Addition* where the *Status* of the lighting in some spaces is *Future* along with other spaces with the *Status* of the lighting being *New* or *Altered*, then *Partial Lighting*
should be checked. If all spaces have the Status of lighting set to New, Altered or Existing, then Lighting should be checked.

**Mechanical and Partial Mechanical.** If the project includes any new mechanical system components, then Mechanical or Partial Mechanical must checked. The status of the systems serving each thermal zone will be used to determine the characteristics of the baseline HVAC systems.

For a New project, if the HVAC systems will be designed and permitted are some point in the future, Mechanical and Partial Mechanical must be left unchecked. The HVAC systems in both the proposed and baseline models, will be specified by the rules and will normally be of the same type, with system capacities determined by sizing runs.

If the HVAC systems for the entire building have been designed and are being permitted, then Mechanical should be checked. If the systems serving some thermal zones are designed and included in the permit, but for other portions of the building will be designed and permitted in the future, such as for a core and shell project, then Partial Mechanical should be checked.

For an Existing project, if Mechanical is unchecked, then the Status of the systems may be set to Existing or at the Thermal Zone, “HVAC is unknown” should be checked. This checkbox is used for either existing systems where the details are unknown or for systems that will be designed in the future. In either case, the rules will determine the system configuration for both the proposed and baseline models with sizing determined by sizing runs.

**DHW.** DHW may be checked or unchecked regardless of other analysis scope options. If it is included, then DHW systems must be specified and all spaces assigned to a residential DHW system or a fluid system of type service hot water. If DHW is not checked, the rules will create systems for both the proposed and baseline models.

---

**Menu Bar**

This section explains the program features you access by selecting the options on the menu bar at the top of the screen.

**File** – The File menu contains the standard functions for file management, loading recently used files, saving a newly created file, print a file and exiting the program.

**Edit** – In addition to the standard Windows™ Cut, Copy, and Paste commands, the Edit menu contains several commands for editing building descriptions. They are:

- **Edit Component**
- **Create Component**
• **Delete Component**

These menus allow you to edit all building components, including components that are not displayed on the tree control. Use this method to edit components like schedules and performance curves.

**Ruleset**—CBECC-Com is designed to support multiple rulesets that implement the requirements in different codes. However, different codes can require different information, and therefore, compliance projects and model inputs defined using one ruleset will likely need to be revised to work with other rulesets. This function may or may not be enabled in this version of the software.

**View** – Enables you to toggle the display of the Tool Bar and the Status Bar on and off.

**Tools** – The Tools menu contains the following options of interest to end-users:

- **Program and Analysis Options** – Allows users to set the various options related to storage of simulation output and analysis files. Also allows users to set the proxy server settings to enable access to the online report generator if the computer is behind a firewall.
- **View T-24 Compliance Report** – Allows users to open an approved CBECC-Com compliance report in the local PDF document viewing software; typically Acrobat Reader. If no valid report or results file is found it will prompt the user to perform the compliance analysis before generating and/or viewing the compliance report.
- **View Project Folder** - Allows easy access to users to open the folder where all the project files are stored and/or generated on analysis.
- **View Project Log File** - Allows users to open the project log file in the local text editor software; typically Notepad.
- **Delete Project Log File** - Allows users to delete the project log file generated for the project. Typically the project log file gets appended with information on opening/saving and running the project. So if the user wishes to start with a fresh project log file this option allows the user to delete the old log file.
- **Perform Analysis** – Performs compliance input checks and simulations based on the current building description.
- **Review Analysis Results** – Allows users to review the results of the last simulation analysis that was performed for the project. Please note that if any changes to the project were made after the analysis and the project was not simulated again, the displayed results would not be current.
- **Generate Draft T-24 Compliance Report** – Generates a watermarked compliance report (pdf) for review/printing. This watermarked report cannot be used to submit for compliance.

**Help** – The Help menu contains the following options of interest to end-users:

- **Quick Start Guide** – Opens up the Quick Start Guide for the software in the local PDF document viewing software.
- **User Manual** - Opens up the User’s Manual for the software in the local PDF document viewing software.

[Return to Quick Start Main Menu]

**Tool Bar**

This section explains the program features you access by selecting the icons on the tool bar at the top of the screen.
New File

This button closes the current file (if one is open) and opens a new file.

Open Existing File

This button closes the current file (if one is open) and launches the Open dialog to enable you to select an existing file to open.

Save File

This button saves the file under its current name or, if you have not named the file, launches the Save As dialog to enable you to provide a new file name.

Cut Selected Item

This button is not currently enabled in CBECC-Com.

Copy Selected Item

This button enables you to copy the selected item on the tree control (along with any child components) to the Windows clipboard. The Copy button is not available from within program dialogs, but you can use the keyboard equivalent, Ctrl+C, to copy selected text.

Paste Contents of Clipboard

This button enables you to paste components copied from the tree control to the selected location in the tree control (provided that location is compatible with the stored component). The Paste button is not available from within program dialogs, but you can use the keyboard equivalent, Ctrl+V, to paste text from the Windows clipboard to the selected input field.

Print

This function is not available in CBECC-Com.

Building Creation Wizard

This function is not available in CBECC-Com.

Perform Analysis

This button enables you to launch a compliance analysis using the currently loaded building description. The behavior of this button identical to the Tools menu option. You must save the current building description before performing the analysis.

Compliance Reports
This icon opens an approved *CBECC-Com Report* in your local document viewing software; typically Acrobat Reader. The behavior of this button is identical to the Tools menu option - “View Compliance Report”. You cannot open an approved report unless an analysis has been performed and the model has not been modified since the analysis has been performed. This button may or may not be enabled in this version of the software.

**About California Building Energy Code Compliance Software**

This button enables you to view program license and version information.

**Print Preview**

This function is not available in CBECC-Com and will be removed in future versions.

**Help**

Not yet implemented. For help with the program, please refer to this Quick Start Guide.

---

**Main Screen**

The main screen of the *CBECC-Com* program is used primarily for editing building descriptions. There are two folder tabs at the top of the main screen—Envelope and Mechanical. These tabs provide different views of the building description and provide access to two different subsets of the building description data.

---

**Right Mouse Button Menu Options**

The *CBECC-Com* program makes extensive use of menu accessible by clicking the right mouse button. The functions available through these menus depend on whether you are on the main screen or in an input dialog window.

**Main Screen Right Mouse Menu.** When clicked over a building component, the following choices are available:

- *Edit* – Opens the input dialog window for the selected component
- *Rename* – Enables you to rename the selected component
- *Delete* – Deletes the selected component
- *Copy* – Copies the selected component with all of its child components
- *Paste* – Adds copied components and their children to the selected component
- *Move Up in list, Move Down in list* – Moves the component up or down in the list of components that share a common parent. The input file is reordered accordingly. HVAC components are reordered and will be simulated with components in the displayed order, except for fans which are ordered based on the Fan Position parameter. For example, an evaporative cooler placed before or after a cooling coil will have different effects in the simulation.
- **View Space Footprint** – Displays in your browser a diagram of the space (available for space components only)
- **Expand/contract** – Expands or contracts the list of children components attached to a selected component
- **Create** – Enables you to create new child components for the selected component

**Input Dialog Right Mouse Menu.** When clicked over an input value in the window, the following choices are available:

- **Item Help** – Not yet implemented. Accesses Help information applicable to the selected input field.
- **Topic Help** – Not yet implemented. Accesses Help information applicable to the selected component.
- **Restore Default** – Returns the value of the field to its default value (if applicable)
- **Critical Default Comment** – Not yet implemented. Opens a dialog enabling you to enter a justification for overriding values designated by the Code as critical defaults, i.e., a value that should only be overridden with special justification.

**Building Tree Controls (Parent/Child Relationships)**

In order to analyze a building's energy use, it is necessary to track relationships among building components. **CBECC-Com** displays these relationships using the familiar tree control, found in Windows™ Explorer and many other applications. For example, under the Envelope tab, exterior walls are shown as parents to windows (windows are connected to exterior walls and appear underneath walls) and children to spaces. The tree controls vary in the components they display and depend on which folder tab is currently selected.

**Use the Tree Control for Rapid Editing**

The tree control can be used to move and copy components or groups of components. To move a component, just drag and drop. If an association isn’t allowed, the program will prevent the move from being carried out. To copy a component, select the component, copy, and paste. It is advisable to rename copied components to maintain readability. Whenever parents are moved, copied, or deleted, all related child components are also moved, copied, or deleted.

Components shown on the tree can be moved using a drag-and-drop technique to other components provided it results in a compatible parent-child relationship. For example, you can drag a window onto a different wall, but not vice versa. Re-ordering of child objects assigned to the same parent is currently not supported.

A set of right mouse menu edit commands can be used with the tree control. These are described in the **Right Mouse Button Menu Options** section. Double-clicking on any component on the tree opens its input dialog window.
Input Dialog Windows

The attributes of each building component can be edited by opening the input dialog window for the component. The dialog can be opened by double-clicking on the component on the tree control, using the Edit option on the right mouse menu, or using the Edit Component option on the Edit menu. (The tree control does not appear until you have created a project description using the wizard or loaded an existing project file [Ctrl+O]).

In keeping with good practice for use of any software, we recommend that you save your building description often and revise the file name once you have substantial effort invested in editing the description under the current file name.

Background Colors

The following background color convention has been used in displaying data on the dialogs:

- White background = available for user input
- Gray background = not user editable

Text Colors

The following text color convention has been used in displaying data on the dialogs:

- Dark blue or cyan text = default values as defined by the current ruleset
- Red text = values that have been changed from their default values

For information on editing features available from the input dialog windows, see the Right Mouse Button Menu Options section.

To understand what information you are required to enter, see the Status Bar section.

Status Bar

The second and third panes of the program status bar now report detailed version IDs of (1) the software and (2) the ruleset that is referenced by the project currently loaded into the program:

Note: The following features of the Status Bar have not been implemented in this version of CBECC-Com.

The status bar at the bottom of the screen provides useful information about each input field you select. There are three panes on the status bar that provide context-sensitive information. This same information is displayed in the ToolTips if you allow your mouse pointer to linger over an input field.

1. Input Description Pane – Concise descriptions of the selected input field are displayed at the far left of the status bar.
2. Input Classification Pane – The next pane to the right on the status bar displays a set of labels that indicates which inputs you are required to provide, which are optional, and which are unavailable for input. The input classification labels are explained in the table below.

3. Data Source Pane – The pane at the far right of the status bar displays a set of labels that identify the source of the information (if any) contained in the field. This can help you distinguish between information that is dictated by the compliance checking process and the information you have entered and for which you are responsible. The data source labels are explained below.

**Input Classification Explanations**

<table>
<thead>
<tr>
<th>No field selected</th>
<th>No building data field is currently selected.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input is compulsory</td>
<td>You are required to enter data in the selected field; the program cannot perform a compliance analysis unless you do.</td>
</tr>
<tr>
<td>Input is required</td>
<td>You are required to enter data in the selected field if the field is applicable to your project.</td>
</tr>
<tr>
<td>Input is optional</td>
<td>You may enter data in the selected field if the field is applicable to your project, but you are not required to do so. If the field contains a default value, you are permitted to simply use that value without considering its suitability for your project.</td>
</tr>
<tr>
<td>Input is critical default</td>
<td>You may overwrite the data in the selected field with an entry more appropriate for your project than the default. However, if you do overwrite this &quot;critical default&quot; value, you must be prepared to provide documentation substantiating the value you have chosen.</td>
</tr>
<tr>
<td>Field is not editable</td>
<td>You cannot enter data in the selected field. The data in this field are defined by the compliance rule set or a supporting process. In some cases, the field may also be an intermediate calculated parameter or one that is not applicable to the currently selected compliance rule set.</td>
</tr>
<tr>
<td>Navigation input</td>
<td>The purpose of the selected field is to enable you to select a component for editing without having to exit the current component and choose the next component from the tree.</td>
</tr>
</tbody>
</table>

**Data Source Explanations**

<table>
<thead>
<tr>
<th>No field selected</th>
<th>No building data field is currently selected.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value from user</td>
<td>The data shown have been defined by the user either directly through a user input or indirectly through wizard selections.</td>
</tr>
</tbody>
</table>
Value from simulation | The data shown have been defined by an energy simulation.
---|---
Value undefined | No data have yet been defined for the field.
Value from program | The data in this field have been defined by the program either to implement requirements and procedures specified in the energy code or to conform to building energy modeling conventions.

**Defining New Components**

There are two main ways to define new components (e.g., walls or equipment) in the main program interface.

**Define a New Physical Component**

To define a new physical component, follow these steps from the Main Program Screen:

- Right-click on the component on the tree control to which you want to add the new component.
- Select Create, then the type of object you want to add. (Only applicable component types will appear on the list.)
- Accept the default name, parent, and existing component to copy from or edit these fields and click OK.
- Edit the input fields with white backgrounds to describe the new component and click OK.

**Deleting Project Files**

If you have created multiple projects under different project names, you may want to delete project files to free up hard disk space on your computer. By default, project files are stored in the C:\Users\<your username>\My Documents\CBECC-Com 2019 Projects\ directory, although where the files are stored may differ on your computer depending upon where you installed the program and if you selected a different location for storing files.

In the Projects folder, you will find several files with the same project name you used but with differing file extensions. If you have no further use for information on a project, delete all files using the primary file name. If you would like to retain a project but store it as efficiently as possible, delete all files using the primary file name EXCEPT the one having a .cibd (input building design) file name extension. The other project files are recreated when an analysis is performed, with the exception of the project .log file. The log file lists compliance analysis warnings and errors shown in the UI, as well as other information related to processing/simulating models. Each time analysis is performed; new messages are appended to the end of this file, and should be reviewed when troubleshooting your compliance analysis.
How to Report a Problem

This software is released for testing purposes and we anticipate the user running into errors and problems. We appreciate your willingness to help us make progress by taking the extra time to document and report issues in a way that will help us fix them quickly.

When you come across an issue, please log an issue at the CBECC-COM website at:
http://bees.archenergy.com/issue.html

If you experience any issues submitting an issue through the website, please send an email to:
CBECC-COM Support <cbecc.com@gmail.com>

And include as much of the following as possible (copy and paste this template into your email):

Type of Issue

CBECC-COM version (Version can be found in the Help-> About menu) and is represented as show below: CBECC-COM 2019

![CBECC-Com version](image)

Describe the error, using as much detail as possible.

List the steps taken to produce the error, using as much detail as possible.

1. Step 1
2. Step 2 etc.

If there is an error message, what is the message? If possible, take a screenshot of the error message and attach it to the email as a file.

Please attach your <ProjectName>.cibd16 file. This is the file you open and save from inside CBECC-Com. By default, this file is located in the following directory, C:\Users\<your username>\My Documents\CBECC-Com 2019 Projects.
If you include your name and phone number, we may call you to clarify the problem or ask for more details. We will not share your name, phone number or email address with anyone outside the CBECC-Com development team or use it for any purpose other than responding to your report.

Return to Quick Start Main Menu
License Agreement

Copyright (c) 2012-2018, California Energy Commission

Copyright (c) 2012-2017, Wrightsoft Corporation

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

- Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
- Redistributions in binary form must reproduce the above copyright notice, this list of conditions, the following disclaimer in the documentation and/or other materials provided with the distribution.
- Neither the name of the California Energy Commission nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission.

DISCLAIMER: THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT ARE DISCLAIMED. IN NO EVENT SHALL CALIFORNIA ENERGY COMMISSION, WRIGHTSOFT CORPORATION, ITRON, INC. OR ANY OTHER AUTHOR OR COPYRIGHT HOLDER OF THIS SOFTWARE (COLLECTIVELY, THE "AUTHORS") BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. EACH LICENSEE AND SUBLICENSEE OF THE SOFTWARE AGREES NOT TO ASSERT ANY CLAIM AGAINST ANY OF THE AUTHORS RELATING TO THIS SOFTWARE, WHETHER DUE TO PERFORMANCE ISSUES, TITLE OR INFRINGEMENT ISSUES, STRICT LIABILITY OR OTHERWISE.
Copyright (c) 2012-2019, California Energy Commission

Copyright (c) 2019, SAC Software Solutions, LLC

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

- Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
- Redistributions in binary form must reproduce the above copyright notice, this list of conditions, the following disclaimer in the documentation and/or other materials provided with the distribution.
- Neither the name of the California Energy Commission nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission.

DISCLAIMER: THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT ARE DISCLAIMED. IN NO EVENT SHALL CALIFORNIA ENERGY COMMISSION, WRIGHTSOFT CORPORATION, ITRON, INC. OR ANY OTHER AUTHOR OR COPYRIGHT HOLDER OF THIS SOFTWARE (COLLECTIVELY, THE "AUTHORS") BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. EACH LICENSEE AND SUBLICENSEE OF THE SOFTWARE AGREES NOT TO ASSERT ANY CLAIM AGAINST ANY OF THE AUTHORS RELATING TO THIS SOFTWARE, WHETHER DUE TO PERFORMANCE ISSUES, TITLE OR INFRINGEMENT ISSUES, STRICT LIABILITY OR OTHERWISE.